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Copyright 

This manual and the software described in it are copyrighted with all rights reserved. Under the copyright laws, 
this manual or the software may not be copied, in whole or part, without written consent of Apple, except in the 
normal use of the software or to make a backup copy. The same proprietary and copyright notices must be affixed 
to any permitted copies as were affixed to the original. This exception does not allow copies to be made for 
others, whether or not sold, but all of the material purchased (with all backup copies) may be sold, given, or 
loaned to another person. Under the law, copying includes translating into another language or format. 

You may use the software on any computer owned by you, but extra copies cannot be made for this purpose. For 
some products, a multiuse license may be purchased to allow the software to be used on more than one computer 
owned by the purchaser, including a shared-disk system. (Contact your authorized Apple dealer for information 
on multiuse licenses.) 

©1986 Apple Computer, Inc. 
20525 Mariani Ave. 
Cupertino, CA 95014 
(408) 996-1010 

Apple, the Apple logo, ImageWriter, AppleTalk, LaserWriter, and Apple Hard Disk 20 are trademarks of Apple 
Computer, Inc. Macintosh is a trademark of McIntosh Laboratory, Inc. and is being used with express 
permission of its owner. 

Simultaneously published in the USA and Canada. 

Limited Warranty on Media and Manuals 

If you discover physical defects in the media on which this software is distributed, or in the manuals distributed 
with the software, Apple will replace the media or manuals at no charge to you, provided you return the item to be 
replaced with proof of purchase to Apple or an authorized Apple dealer during the 90-day period after you 
purchased the software. In some countries the replacement period may be different; check with your authorized 
Apple dealer. 

ALL IMPLIED WARRANTIES ON THE MEDIA AND MANUAL, INCLUDING IMPLIED 
WARRANTIES OF MERCHANT ABILITY AND FITNESS FOR A PARTICULAR PURPOSE, 
ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE OF THE 
ORIGINAL RETAIL PURCHASE OF THIS PRODUCT. 

Even though Apple has tested the software and reviewed the documentation, APPLE MAKES NO 
WARRANTY OR REPRESENTATION, EITHER EXPRESS OR IMPLIED, WITH RESPECT 
TO THIS SOFTWARE, ITS QUALITY, PERFORMANCE, MERCHANTABILITY, OR 
FITNESS FOR A PARTICULAR PURPOSE. AS A RESULT, THIS SOFTWARE IS SOLD 
"AS IS," AND YOU, THE PURCHASER, ARE ASSUMING THE ENTIRE RISK AS TO ITS 
QUALITY AND PERFORMANCE. 

IN NO EVENT WILL APPLE BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM ANY DEFECT IN 
THE SOFTWARE OR ITS DOCUMENTATION, even if advised of the possibility of such damages. In 
particular, Apple shall have no liability for any programs or data stored in or used with Apple products, including 
the costs of recovering such programs or data. 

THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU 
OF ALL OTHERS, ORAL OR WRITTEN, EXPRESS OR IMPLIED. No Apple dealer, agent, or 
employee is authorized to make any modification, extension, or addition to this warranty. 

Some states do not allow the exclusion or limitation of implied warranties or liability for incidental or 
consequential damages, so the above limitation or exclusion may not apply to you. This warranty gives you 
specific legal rights, and you may also have other rights which vary from state to state. 



Macintosh Plus 
Internal Disk Drive 



Acknowledgments Writer: Carol Kaehler 
Editors: George Truett Bush, Darcy DiNucci 
Production Supervisors: Mark Seymour, Laurie Sheldon 

2 Maciritosh Plus Internal Disk Drive 



Contents 5 What the Macintosh Plus Disk Drive Kit Includes 

6 Updating Startup Disks 

9 About Finder 5.1 
9 Zoom Box 

10 New Commands in Finder 5.1 
14 Using Directories in Text Views 
15 Dragging Icons 
15 Naming Icons 
16 Ejecting Disks 
16 Using the MiniFinder 

20 New Desk Accessories 
20 Chooser 
21 Control Panel 
24 Key Caps 

25 Using Folders From Within Applications 

32 Initializing Double-Sided (SOOK) Disks 

35 About Startup Disks 

37 Using the FontlDA Mover to Customize Startup Disks 

Contents 3 





What the 
Macintosh Plus 
Disk Drive Kit 
Includes 

Your authorized Apple® dealer has upgraded your Macintosh™ with new 
ROM and an BOOK internal disk drive. Now you have a faster Macintosh and 
you can use double-sided 3 1 12-inch disks to store twice as much information 
as you could on a single-sided disk. Your upgrade also includes the 
Macintosh Plus System Tools disk, which provides the system software you 
need to take advantage of your new hardware. 

Note: When you switch on your upgraded Macintosh the first time, a piece of 
yellow plastic pops out of the disk drive. Keep this piece of plastic, and 
reinsert it if you ever need to transport your Macintosh a great distance. The 
plastic piece protects the disk drive. 

This manual describes 

o Updating startup disks to have the Macintosh Plus system files. 
You can do this by creating new Macintosh Plus startup disks on 
double-sided disks you format two-sided or by using the Installer to 
update existing startup disks. It's important to use only startup disks that 
have Macintosh Plus system files with your upgraded Macintosh. 

o The Macintosh Plus system software-Finder version 5.1 and the 
updated System file, which includes the new Chooser, Control 
Panel, and Key Caps desk accessories. 

o Initializing double-sided (SOOK) disks two-sided, so they can use 
the new hierarchical file system that makes the folders you create in 
the Finder available from within applications as well. (You'll still be able 
to use a 400K disk drive with your upgraded Macintosh as long as you 
initialize disks you use in it one-sided.) 

o The Font/DA Mover version 3.0, which you can use to customize 
startup disks to have the fonts and desk accessories you want. 

o Startup disks-what they control, how to customize them, and how to 
know which startup disk the Macintosh is currently using. Read this 
section if you've ever wondered why you sometimes have different fonts 
or desk accessories available in applications or why the version of the 
Finder you're using changes without notice. 
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Updating Startup 
Disks 
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The Macintosh Plus SystemTools disk contains the very latest in system files. 
These files (which are in the System Folder) include 

o Finder 5.1. 

o The updated System file . This System file has the new Chooser, Control 
Panel, and Key Caps desk accessories. Also, this System file makes the 
new hierarchical file system available when you use double-sided (800K) 
disks and you initialize them with the two-sided format. This means you 
can use folders from within applications as well as in the Finder. See 
"Initializing Double-Sided (800K) Disks." 

o New printing resources for the ImageWriterm (which works with either an 
originallmageWriter or an ImageWriter II), AppleTalkm ImageWriter (for 
the ImageWriter II with AppleTalk option), and the LaserWriterm. 

Important: Update each of your startup disks to have these new system files. 

A startup disk is any disk that you can use to start up the Macintosh. It always 
contains a System Folder with at least a System file and a Finder. 
Applications you purchase include a startup disk. 

Check to see which version of the Finder each of your startup disks has by 
starting your Macintosh with that disk and choosing About the Finder from the 
Apple menu. If the version number isn't 5.1, update that startup disk. 

Creating a Macintosh Plus Startup Disk 

The simplest way to update to Macintosh Plus system files is to create new 
Macintosh Plus startup disks. (Before you alter any disk, make a backup 
copy.) Here's how to make a new Macintosh Plus startup disk: Start up 
using the Macintosh Plus System Tools disk; insert a new double-sided disk 
(first eject the Macintosh Plus System Tools disk if you have just one 800K 
disk drive). Click Two-sided, name the disk, drag the System Folder from the 
Macintosh Plus System Tools disk to the new disk, choose Shut Down from 
the Special menu, restart the Macintosh with your new startup disk, and drag 
any applications you want from other disks to your new disk. 
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Using the Installer to Update Disks 

If you're using a copy-protected application on the startup disk, or you're 
using an application or hard disk that requires a specially modified system 
file, use the Installer to update to Macintosh Plus. 

The Installer installs the new Finder (version 5.1), updates the System file to 
have the latest versions of the Chooser, Control Panel, and Key Caps, and 
replaces any existing ImageWriter or LaserWriter printing resources with the 
new resources. 

• Start up the Macintosh using the Macintosh Plus System Tools 
disk. 

• Open the Installer by selecting it and choosing Open from the 
File menu or by double-clicking its icon. 

The Installer is in the Utilities Folder on the Macintosh Plus System Tools 
disk. 

• Insert the startup disk you want to update. 

If you have a one-drive system, first eject the disk that contains the 
Installer. The Installer will update the startup disk named at the top right. 

• Click Macintosh Plus. 

Current disk ----------------------___ 

Instoller 

AppleTolk I mogeWriter (u 2.1) 
I mogeWriter (u 2.1) 
loserWriter (u 1.1) 
Macintosh Plus (u 1.0) 

[ !nst d!! ) 

[H ~~nwup 1 
[ HelP) 

[ Quit) 

Pleose select the resources ond the disk you wont to 
instoll them on. 
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This will install Macintosh Plus system improvements and update any 
existing printing resources. You can also select any of the printing 
resources to add them to disks they're not currently on. Use the 
Shift-click technique to select more than one option. 

You can later use the Font/DA Mover to customize the disk with the fonts 
and desk accessories you want to use with it. 

• Click Install to install what you selected or click Remove to 
remove it. 

Use the Drive and Eject buttons to work with other startup disks. 

• Click Quit when you've finished updating all of your startup 
disks. 

A Note About the Apple Hard Disk 20m: If you purchase a new Hard 
Disk 20, once you connect it to your upgraded Macintosh and start up with an 
updated startup disk, you'll be asked if you want to initialize the hard disk. 
Once you've done this, make the Hard Disk 20 a startup disk by dragging the 
System Folder from the System Tools disk to the hard disk. You won't need 
the HD 20 Startup disk at all. 

If you already own a Hard Disk 20, use the Installer to update the Hard 
Disk 20 system files just as you update other startup disks. With your 
upgraded Macintosh you no longer need to start up your Hard Disk 20 with an 
HD 20 Startup disk. 

A Note to LaserWriter Users: If you share an AppleTalk network with 
"nonplused" Macintoshes, it's important that the nonplused Macintosh users 
also update each startup disk they use while connected to AppleTalk. These 
users won't be able to use the Installer on an aOOK disk, so either copy the 
Installer, System Folder, and FontlDA Mover to a 400K disk, or update their 
startup disks at your Macintosh. 

As a general rule, Macintoshes that share an AppleTalk network should 
always have identical versions of LaserWriter printing resources. Check 
version numbers of LaserWriter printing resources on any installation utility 
programs you have. Make sure everyone on your network installs the latest 
version number available. For example, use 1.1 rather than 1.0. 

Macintosh Plus Internal Disk Drive 



About Finder 5.1 The Finder is the application you use to manage your Macintosh desktop. 
The new Finder (version 5.1) is faster than previous versions and it works 
better with hard disks. It also has some added features such as the 
MiniFinder, which lets you move quickly among the applications and 
documents you use most often. The new Finder works with any existing 
applications and documents without your having to make any changes to 
them. 

Finder 5.1 is very similar to Finder 4.1, an update available in spring, 1985. If 
you've used Finder 4.1, you'll find you're already familiar with most of the new 
features. 

Note: Old versions of the Finder may not always show folders or their 
contents on disks you've formatted two-sided. This is another reason to 
update every startup disk you use. 

Zoom Box 

0 Memoranda Zoom box 

Name Size Kind 

.i~Mdm" 4K MacWrit ~ 
CI Staff meeting minutes 4K MacWrit 

CI Internal Disk Drive Contents 4K MacWrit J 
CI Internal Disk Drive final 4K MacWrit 0 

K;JI 10 I2J 

Clicking the zoom box at the top right corner of directory windows in 
Finder 5.1 expands the window to nearly cover the desktop. (You can still 
see the icons at the right of the desktop.) Clicking the zoom box again shrinks 
the window back to its former size. 

The zoom box is available to any application written to take advantage of the 
new ROM. Right now, zoom boxes appear only in the Finder; watch for them 
in new versions of your favorite applications. 

About Finder 5.1 9 
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New Commands in Finder 5.1 

The II (Apple) Menu 

( ~ File Edit Uiew Special 
Rbout the Finder ... 

Rlarm Clock: 
Calculator 
Chooser 
Control Panel 
Key Caps 
Scrapbook: 

About the Finder 

The About the Finder command in the Apple menu now tells you the memory 
size of the Macintosh you're using. 

Desk Accessories 

New versions of the Chooser (formerly Choose Printer), Control Panel, and 
Key Caps are included on the Macintosh Plus System Tools disk. These 
accessories are installed on startup disks you update using the Installer. See 
"New Desk Accessories." 

You can customize each of your startup disks to have the desk accessories 
you want, including the desk accessories in the Fonts and Desk Accessories 
files in the Utilities Folder on the System Tools disk. See "Using the FontiDA 
Mover to Customize Startup Disks." 

The File Menu 

Open :leO 
Print 
Close 

Get Info :leI 
Duplicate :leD 
Put Rway 

Page Setup 
Print Catalog 

ect :leE 
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New Folder 

Choosing New Folder creates a new folder (so you no longer have to 
duplicate an existing folder) . You can rename the folder immediately after 
you create it, by typing the name you want. Rename it any other time by 
selecting the name or icon and editing the name in the usual way. 

The new folder appears in the active window on the desktop. It's named 
"Empty Folder" unless a folder named "Empty Folder" already exists; then it's 
named "Copy of Empty Folder." The command is dimmed if no directory 
windows are open. 

Put Away 

When any documents, folders, or applications are selected on the desktop or 
in the Trash window, choosing Put Away puts them back in the folders and 
disks where they belong . If a disk icon is opened in a directory window, the 
items you put away appear there; otherwise they appear the next time you 
open the disk icon. This command is dimmed when no icons are selected on 
the desktop or in the Trash window. (If you 're using a disk that's initialized 
one-sided, the items are put back at the disk level of the di rectory, not in any 
folders.) 

Page Setup 

The Page Setup command lets you set up the page size, orientation, and 
other options of directories you print using the Print Catalog command. In the 
Finder, this command works only with the Print Catalog command ; a 
document's page setup is controlled by the Page Setup command in the 
appl icati on. 

Print Catalog 

The new Print Catalog command in the File menu prints the contents of the 
active directory window-arranged in whatever view you've chosen from the 
View menu. 

Note: Close All has been removed from the File menu. You can get the 
same effect by holding down the Option key while you choose Close. 

About Finder 5.1 11 
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The View Menu 

• File Edit 

By Small Icon 

Special 
by S all Icon 

"'by Icon 
by Nome 
by Dote 
by Size 
by Kind 

Shows the contents of the active directory window with miniature icons to the 
left of the icon names. This view is especially helpful when you have a large 
number of documents and applications on a disk-if you have a hard disk, for 
example. Once you've arranged the directory by small icon, you can hold 
down the Option key while you choose Clean Up from the Special menu to 
place the icons as compactly as possible. 

.Mac'w'rit~ 

II Ad for Didi~r 

~ Moving Docs 

Macintosh Plus Internal Disk Drive 

~Font/DA 1 

~ Op~n/Sav~ 1 

~ Op.n/Sav~ 2 

~Macpaint 



The Special Menu 

s.~ t S1 <11"1 up 
U~.~ :v1i(\iI'ind(~I"", 

Shut Down 

Use MiniFinder." 

To move quickly among applications, you can now place the applications and 
documents you use most often in the MiniFinder. See "Using the MiniFinder" 
for how to use this command, 

Shut Down 

Choosing Shut Down ejects any inserted disks (first saving any necessary 
information) and then restarts the Macintosh. This is the best way to restart 
the Macintosh using a different startup disk. It's also the fastest way; when 
you use the Shut Down command, your Macintosh doesn't have to go 
through a memory test as part of restarting. 

About Finder 5.1 13 
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Using Directories in Text Views 

With the original Finder you could duplicate, move, rename, or discard 
documents, folders, and applications only when directory windows were 
arranged by icon. With Finder 5.1 you can do any of your desktop work with 
your directories in any arrangement-by icon, name, date, size, or kind. In 
any of the text views (any view other than by icon or small icon), a small icon 
appears to the left of the document name. Click, double-click, drag, or 
Shift-click this icon just as you would its counterpart in an icon view of the 
directory. 

CO~~Hpond.ne. 

To rename a document when a directory isn't arranged by icon, select the 
name and edit it just as you edit icon names in an icon view or on the 
desktop. 
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Directories in text views also indicate (with a small padlock on the right) which 
of your documents and applications are locked. If you physically lock the 
disk, the padlock appears in the top left corner just below the title bar. 

Ted's Proposol [! 
Kind: MocWrite document 
Size: 18613 bytes, occounts for 19K on disk 
Where: Write, internol driue 

cked 

Fridoy, Jonuory 24, 1986 ot 9:38 RM 
Fridoy, Jonuory 24, 1986 ot 10:40 

Locked ------------~+_-----------------------4----~~~~ 

Dragging Icons 

In the past, you couldn't drag an icon to a "hollow" icon; you had to drag to the 
icon's directory window. Now you can drag an icon either to a directory 
window or to the hollow icon that remains behind when you open an icon. If 
you drag to a directory window, you can place the icon wherever you want it; 
if you drag to a hollow icon, the Finder will place it in the next available spot. 

Naming Icons 

In the past, typing renamed any selected icon, whether you had explicitly 
clicked it or not. For example, if you insert a disk, it's automatically selected, 
even though you didn't click it; with the original Finder, subsequent typing 
renamed that disk. Now you must click explicitly on an icon or icon name to 
edit its name, even if the icon is already selected. This means you're less 
likely to rename disks accidentally. There are a couple of exceptions: When 
you create a new folder by choosing New Folder, or when you duplicate or 
move a document, folder, or application, typing renames what's selected, 
without your having to click it first. (This is true in text views as well.) 

If you give an icon a name that's the same as an icon you just dragged to the 
Trash, the Trash is automatically emptied, so you can use the name again. 

About Finder 5.1 15 
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Ejecting Disks 

Now choosing Eject always ejects a disk (if one's inserted and it isn't a hard 
disk), even if none is selected. The Finder looks for any inserted disk to eject. 
Choosing Eject again ejects any other inserted disk. 

You can't edit an ejected disk's comment box (in the Get Info window) or that 
of any of the documents on that disk. 

If you want your Macintosh to forget about a disk (and not ask for it again), 
drag the disk icon to the Trash. This doesn't erase the disk; it just ejects it and 
removes the icon from the desktop. Dragging the current startup disk to the 
Trash ejects it but doesn't remove the icon from the desktop. 

Using the MlnlFlnder 

The MiniFinder lets you move among documents and applications faster than 
you can by returning to the Finder each time you want to work with a different 
application. You might want to place the documents and applications you 
use most often in the MiniFinder. 

You can install the MiniFinder on any of your disks that contain applications, 
whether or not they're startup disks. The Macintosh Plus always starts up 
with , and applications quit to, any MiniFinder on the current startup disk, but 
you can see the contents of MiniFinders on other disks by pressing the Drive 
or Eject buttons in the MiniFinder. 

The MiniFinder is included in Finder 5.1, which is installed on any startup disk 
you update using the Installer. See "Using the Installer to Update Startup 
Disks." 

To install applications and documents in the MiniFinder 

• In the Finder, select what you want to install in the MiniFinder. 

You can select up to 12 mixed or matched documents and applications. 
The documents and applications you select must be in the same directory 
window or all on the desktop; drag them there if necessary. Any 
applications you need to work on documents in the MiniFinder must be on 
the same disk as the documents, but they don't need to be installed in the 
MiniFinder. If you move an application to a different folder after you 've 
installed the MiniFinder, however, the MiniFinder won't be able to find it. 
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• Choose Use MiniFinder from the Special menu. 

If the command is dimmed, check to see if the disk is locked. 

Instoll the MiniFinder using the 
selected documents or opplicotions, or 
remove the MiniFinder. 

Im,,\ [Remove) [Concel) 

• 14MfMd .. 
IIMMI 

~ 
~ 

Letter to Linda 

R.union Invitation Harriet·s Gar age Sale 

• Click Install. 

~ 
.Hlme. 

A MiniFinder icon is placed in the System Folder. 

The next time you start your Macintosh using this disk, or quit an application 
on this disk, the MiniFinder will appear instead of the usual desktop. 

About Finder 5.1 17 
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To use the MiniFinder 

• Open an application or document in the MinlFinder by 
selecting it and clicking Open or by double-clicking its icon. 

~ 
~ 

MocWrite 

~ 
MocPoint 

~ IJ 
Letter to Mo... Proposol9/3 

~ 
Letterheod 

Rpplicotions Disk 

Finder 

Eject 

DrilJe 

Shut Down 

• Return to the Finder by clicking Finder or pressing the Enter 
key. 

If the current disk (the one named at the top right) has no Finder, click 
Drive or press the Tab key first. 

• Open other applications on the same or different disks by 
clicking Open Other. 

A dialog box appears, with a list of all applications on the current disk. 
You use folders and open applications in this dialog box the same way 
you use folders and open documents within applications. See "Using 
Folders From Within Applications." You can use the Drive and Eject 
buttons to see applications on other disks. 

• Eject any Inserted disks and restart the Macintosh by clicking 
Shut Down. 
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• See MiniFinders Installed on other disks by using the Eject 
and Drive buttons. 

To change what's in the MiniFinder, return to the Finder by clicking Finder in 
the MiniFinder (click Drive first, if there's no Finder on the current disk) and 
reinstall the MiniFinder with the documents and applications you want. 

To remove a MiniFlnder from a disk 

• In the Finder, choose Use MlniFinder from the Special menu. 

• Click Remove. 

Dragging the MiniFinder icon from the System Folder to the Trash also 
removes the MiniFinder. 

About Finder 5.1 19 
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Chooser 

user nerne II 

The Macintosh is preset to print documents on an ImageWriter connected to 
the Printer port. You'll use the Chooser only if you want to print on another 
printer such as a LaserWriter or ImageWriter with the AppleTalk option or if 
you want to designate the Modem port for your ImageWriter because another 
piece of hardware is physically connected to the Printer port. 

• If you're using AppleTalk, make sure it's attached to the 
Printer port and designated as connected In the Control Panel. 

See "Control Panel." 

• Choose Chooser from the Apple menu. 

If the Chooser is not installed in the Apple menu, see "Using the Installer 
to Update Startup Disks." 

• Select the Icon that represents the type of printer you want to 
use-lmageWriter, LaserWriter, or AppleTalk Imagewriter. 

The Chooser presents icons that represent the types of printers for which 
there are printing resources on the current startup disk. See "Using the 
Installer to Update Startup Disks." If AppleTalk is disconnected, the 
LaserWriter icon is dimmed. See "Control Panel." 
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• Select additional options. 

If you're using an ImageWriter, select the icon that represents the port the 
ImageWriter is attached to. If you're using a LaserWriter, select the name 
of the LaserWriter you're using. 

The ImageWriter resource works with an ImageWriter, ImageWriter II, or 
15-inch ImageWriter. 

If you've installed other printing or device resources, you may have 
different options, depending on what you've installed. You can later drag 
any resources you don't need to the Trash to gain space on the disk. 

• Type your name to have the Macintosh remember who you are. 

Control Panel 

AppleTalk + ~ o Connected . -

(I) Disconnected" " 

+ 
+0 

Your Doub le-Click Speed 

Mouse Tracking 
···1 

a -.-;:~~ cLJ 
.~~----------~ (I) 0 Spoaker 

Volume Rate of Insertion 
Point Blinking 

····1 .... 
0" ". 

0(1)0 
Slow Fast 

Mouse Tablet 

RAM I""32i(l r+I 0 (I) 
Cache ~ l:!:J On Off 

Like the original Control Panel, the new Control Panel is where you set your 
personal preference for speaker volume and other options. It's also now the 
place you connect or disconnect AppleTalk. 
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To set the Desktop Pattern 

Click dots to change them from black to white or vice versa, or drag 
through a group of dots to change all of them. Click the white "menu bar" 
to see a sample pattern. (Click on the right side of the bar to see the next 
pattern; click on the left side to back up.) Set the pattern by clicking the 
"desktop" below the white bar. 

To connect or disconnect AppleTalk 

The AppleTalk connection setting in the Control Panel should always match 
whether your Macintosh is connected physically to AppleTalk or not. Always 
connect or disconnect Apple Talk physically first, and then immediately 
change the setting in the Control Panel to correspond. . 

Click Connected if your Macintosh is physically connected to AppleTalk. 

To set the Speaker Volume 

Dial the volume you want by dragging the knob up or down. Dialing the 
lowest volume causes the Macintosh to alert you subtly by blinking the menu 
bar rather than by beeping. 

To set your Double-Click Speed 

Click the leftmost check box for the Macintosh to interpret fairly slow 
successive clicks as a double-click. Click the rightmost check box to require a 
faster mouse-button finger. Click the middle check box if you're somewhere 
in between. 

To set Mouse Tracking 

Click the Mouse check box if you're using a mouse. You won't have to move 
the mouse as far as you otherwise would when you want to jump to another 
part of the screen. Or click the Tablet check box if you're using a graphics 
tablet. The Tablet setting keeps the pointer speed constant. 

To set the Rate of Insertion Point Blinking 

Click any check box from Slow to Fast to set the rate at which the vertical bar 
marking the insertion point blinks. 
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To use the RAM Cache 

Set it on. 

Use the arrows to scroll to the amount of memory you want to use for the RAM 
Cache. Using the RAM Cache can greatly speed up your work with the 
Macintosh. When you use the RAM Cache, some of the information an 
application needs is stored in a part of memory you reserve just for the RAM 
Cache. Then, if the application needs the information again, it doesn't have 
to get it from the disk, but rather can get it much more quickly from the RAM 
Cache. 

Using the RAM Cache does make less memory available to applications, so 
you might not want to use it (or use a smaller amount of it) with applications 
that require large amounts of memory. If you have a 512K system, try setting 
the RAM Cache to 128K. On a 1 megabyte system, try 512K. 

To set the Key Repeat Rate 

Click any check box from Slow to Fast to set the rate at which a pressed key 
will repeat once it starts repeating. 

To set Delay Until Repeat 

Click any check box from Long to Short to set the length of time the Macintosh 
waits until it starts repeating a key you're pressing. Click Off to turn off key 
repeating. Set a longer delay if you're getting a lot of repeated keys when 
you don't intend them. 
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Key Caps 

Have you ever wandered through fonts holding down various combinations of 
the Option and Shift keys looking for special characters you know are 
available but don't know how to find? With the new version of the Key Caps 
desk accessory you can see the characters in any font in the current startup 
disk's System file. (With the original Key Caps you could see only the 
Chicago font.) 

When the new Key Caps is the active window a Key Caps menu appears in 
the menu bar. Choosing any font in this menu displays that font's characters. 
You can press the Option, Shift, or Caps Lock key on the Macintosh keyboard 
or press the Option and Shift keys together to see all of the available 
characters in the selected font. 

Key Caps displays characters for the keyboard that is physically attached to 
your upgraded Macintosh-either the original or the new Macintosh Plus 
keyboard. 
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Using Folders 
From Within 
Applications 

In the past, the directory of documents that appeared when you chose Open 
from the File menu was "flat," without any hierarchy you created using folders in the Finder. So even if you had nested a document within several layers of 
folders in the Finder, the directory you saw within applications showed the 
document in a single layer with all the other documents in other folders or not 
in a folder at all. And when you chose Save As or you saved a document for 
the first time, your document was always saved at the disk level without being placed in a folder. 

With your upgraded Macintosh all that has changed. When you're using a 
double-sided disk you've initialized two-sided and you're using a startup disk 
you've updated using the Installer, you can see and use the same folders you create in the Finder from within applications as well. You see the folders 
whenever you choose Open or Save As or you save a document for the first time. 

To open an existing document from within an application 

• Choose Open from the File menu. 

First close any open document if necessary. 

Directory name ----I--::---;tt"---~~!!!d!!:!.!!..~ 
D Project Schedules ~ 
D System Folder 
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A dialog box appears, with a directory of the contents of the current folder 
or disk. In the past you sawall the current application's documents that 
existed on the entire disk. Now you see only the current folder directory 
or the disk directory at the top level-documents or folders on the desktop 
or on the disk and not in any folder. The directory name (and a folder or 
disk icon) is above the alphabetized list of the directory's contents; the 
name of the current disk (and a disk icon) appears to the right. 

The folders in the dialog box correspond to the folders you create in the 
Finder. 

The folders in these directories show only the documents the current 
application can open, even if the corresponding folders in the Finder 
contain other documents or applications. 

• To see the contents of a folder in the current directory, select 
the folder's name and click Open, or just double-click its 
name. 

You can move through the entire hierarchy this way, double-clicking any 
folder to see its contents, until you reach the document you want to open. 

In the past, whenever you chose Open from within an application, you 
could type a character to select the first document starting with that 
character (or the first document to follow in alphabetical order). Now as 
you continue to type additional characters, any file that matches the 
characters you type is found and selected. If you pause while typing, the 
next character is considered to be a new request, rather than a 
continuation of your first request. The Delay Until Repeat setting (which 
you set in the Control Panel) determines how long you can pause before 
additional characters are considered to be a new request. See "Control 
PaneL" 

You can also use the direction keys on the Macintosh Plus keyboard to 
move up and down the list of names. 
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o Cd (g) Project~ '85 " / 
o EHecutiue Summaries 
D Files Transfer 
D LOB Relocation 
D Operations Relocation 

r IQ (g) Projects '85 

Eject 

Open 

to Concel 
~------------------~~ 

• To move back up the hierarchy of folders, press the directory 
name and choose the folder or disk directory you want. 

A pull-down list appears below the directory name when you press the 
name or anywhere in the bar that contains the name. Each folder in the 
hierarchy is in the list, and the disk directory (the top level of the 
hierarchy-anything on the disk that's on the desktop or not in any folder) 
is at the end of the list. 

• To see documents and folders on other disks, use the Drive 
and Eject buttons. 

• Open the document you want to work on by clicking its name 
and then clicking Open or by double-clicking its name. 

You always enter the hierarchy of folders at the place you last opened a 
document from or saved a document to . 
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To save an existing document with a different name, In a different 
folder, or on a different disk, or to save an untitled document 

• Choose Save As from the File menu. 

10/22 
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Save current document 

Eject 

Save 

Cancel 

A dialog box appears, with a directory of the contents of the current folder 
or disk. The directory name (and a folder or disk icon) is above the 
alphabetized list of the directory's contents, including other folders, 
applications and documents. Items other than folders appear dimmed in 
the list. 

The name of the current disk (and a disk icon) appears to the right. 

• To see other folders in a folder In the current directory, 
double-click the folder's name. 

You can move through the entire hierarchy this way, double-clicking any 
folder you want to open to see its contents, until you reach the folder you 
want to save your document in. 
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• To move back up the hierarchy of folders, press the directory 
name and choose the folder or disk directory you want. 

A pull-down list appears below the directory name when you press the 
name (or anywhere in the bar that contains the name). Each folder in the 
hierarchy is in the list, and the disk directory (the top level of the 
hierarchy-anything on the disk that's on the desktop or not in any folder) 
is at the end of the list. 

• To see folders on other disks, use the Drive and Eject buttons. 

• Type a new name for the document If It's a new document or if 
you want to change the current name; otherwise It will be 
saved with the current name. 

Document names can now be any length up to 31 characters. (Disk 
names are now limited to 27 characters.) You can use any character on 
the keyboard, including spaces, except a colon. 

With the hierarchical file system you can have more than one document 
with the same name on the same disk, as long as they're in separate 
folders. If you do this, however, you do need to pay a little more attention 
to which version of the document you're currently working on because 
you may have another version with the same name in a different folder. 

Directory current 10/22 
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• Click Save to save the document In the current directory. 

The document is saved in the folder or disk directory named above the 
list. 

You always enter the hierarchy of folders at the place you last opened a 
document from or saved a document to. 

If the disk you're looking at has been initialized one-sided, the disk directory 
that appears shows no folders. You can copy the one-sided disk to a 
double-sided disk you initialize two-sided and be able to see the disk's 
folders. Also make sure you're using an updated startup disk. 
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Initializing 
Double-Sided 
(800K) Disks 

32 

With the Macintosh Plus BOOK Disk Drive you can use double-sided 
disks-disks with BOOK of space to store your information. Apple 
double-sided disks are snowy white in color and inscribed "Double Sided" on 
the metal part of the disk. You can also use single-sided (400K) disks in your 
BOOK disk drive. 

Whenever the Macintosh encounters a disk it can't interpret, a dialog box 
appears and asks whether you'd like to initialize the disk. When the disk is in 
your upgraded Macintosh and you're using an updated startup disk, you have 
three choices-to initalize the disk with either a one-sided or two-sided 
format, or to eject the disk without initializing it. 

Even when you initialize a disk two-sided, you always insert disks in the same 
way, metal end first, label side up. The disk drive is able to get information 
from both sides of the disk. 

If you're using an external 400K disk drive, you're offered just two choices­
initialize the disk (one-sided) or eject. 

In the Finder you can also initialize disks that have information on them by 
choosing Erase Disk from the Special menu. This erases everything on the 
disk and gives you the same choices for initializing the disk. 

Applications you purchase may be on 400K, single-sided disks. Copying 
them to a double-sided disk you've initialized two-sided and then using the 
Installer to update them lets you use folders from within applications on those 
disks and gives you twice as much space for your own information. Some 
applications may be copy-protected; use these applications from the disk 
they're on, and save documents on double-sided disks. 

To Initialize both sides of a double-sided disk 

• Insert a new double-sided (SOOK) disk you want to initialize. 

tj' ... :;;:.l ............ 

. . 

This disk: is unreadable: 

Do you want to initialize it? 

( Eject ) (one-Sided) 
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• Click Two-Sided. 

This formats the disk to use the hierarchical file system that lets you use 
folders from within an application as well as in the Finder. Whenever you 
choose Open or Save As or save an untitled document while you're in an 
application, you'll see and be able to use the same folders you use in the 
Finder. See "Using Folders From Within Applications." 

• If necessary, type a name for the disk. 

You can use any character or symbol on the keyboard except a colon. 
You can use uppercase or lowercase letters and put spaces between 
words. Names can be any length up to 27 characters, but long names 
can become unwieldy when you drag the icons around. It's best to limit 
names to the space you have to type them in. 

Once you initialize a disk two-sided, you won't be able to use that disk in 
a 400K disk drive. The Macintosh will tell you it can't read the disk and 
offer you the chance to initialize or eject the disk; clicking Initialize at that 
point will completely erase the disk. 

Note: Never initialize a single-sided (400K) disk two-sided. Even though 
your Macintosh will offer you the chance to do this, you'll regret it if you do. 
400K disks are certified on one side only, and if you initialize them two-sided, 
any information you save on them sits there precariously, guaranteed to 
vanish when you're about to print a final draft you've forgotten to back up. 

To initialize a disk you want to use in a 400K disk drive 

To use an external 400K disk drive you may already own or to use disks in 
other Macintoshes that haven't been upgraded, you can initialize a disk on 
one side only, whether it's a double- or single-sided disk. If you initialize a 
disk one-sided, you'll have just 400K available on that disk, even if it's a 
double-sided disk, and you won't see folders from within applications on that 
disk. 

• Insert any new disk. 

• Click One-Sided. 

• If necessary, type a name for the disk. 

You can use any character or symbol on the keyboard except a colon. 
You can use uppercase or lowercase letters and put spaces between 
words. Names can be any length up to 27 characters, but long names 
can become unwieldy when you drag the icons around. It's best to limit 
names to the space you have to type them in. 
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Of course, you can also initialize disks in an external 400K disk drive. A disk 
in a 400K disk drive will automatically be formatted on one side only. 

An external aOOK disk drive (which you can purchase) gives you the same 
choices as your upgraded internal disk drive. 

To avoid confusion, be sure to give disks different names. 

You can initialize disks from within an application without losing any 
information in memory, so you can initialize them as you need them. 

Holding down the Option key while you click One-Sided (or if the disk is in a 
400K disk drive, holding the Option key down while you press the Return key 
after you 've named it) installs the hierarchical file system on just one side of 
the disk. Use disks initialized this way with updated startup disks only. 
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About Startup 
Disks 

Disks that contain the files the Macintosh needs to get itself started and 
perform system-wide tasks are called startup disks. These System files are in 
a System Folder, and, though it's possible to move them from there, it's 
generally best to keep them there. 

A startup disk always includes at least a System file and a Finder. It also 
usually includes one or more printing resources, such as the ImageWriter, 
AppleTalk ImageWriter, or LaserWriter file on the System Tools disk. You 
may also find other system files on a startup disk: Scrapbook file, Clipboard 
file, etc. These files contain information that's used only by certain 
applications and desk accessories. 

Besides giving the Macintosh the information it needs to get itself started, the 
system files on the startup disk determine 

o Which fonts you have available when you use an application (they're in 
the System file on the startup disk you're using). 

o Which desk accessories are in the Apple menu (they're also stored in the 
System file). 

o What's in the Scrapbook or Note Pad desk accessories (whatever's in the 
Scrapbook or Note Pad files on the startup disk). 

o . Which version of the Finder you're using . 

It's good idea to keep all of your startup disks current with the latest system 
files. For example, some applications' startup disk may not have the most 
current system files. See "Using the Installer to Update Startup Disks." 

Customizing Startup Disks 

You can use the FontJDA Mover (Font and Desk Accessory Mover) to 
customize the System file on any startup disk so it contains the fonts and 
accessories you want available when you use applications with that disk. 
Applications you purchase may already be customized with fonts or 
accessories suited to that application. The FontJDA Mover lets you copy 
these to any other startup disk as well. See "Using the FontJDA Mover to 
Customize Startup Disks." 

You can also customize a startup disk by dragging other system files such as 
the Scrapbook or Clipboard files to it-to have different Scrapbook contents 
available from time to time, for example. 
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Current Startup Disk 

When you start your Macintosh, it looks for a startup disk in its internal disk 
drive; if it finds none there, it looks in an external drive if one's attached. Next 
it searches for any hard disks. The first startup disk the Macintosh finds 
becomes the current startup disk, the disk whose system files the Macintosh is 
currently using. The current startup disk appears at the top right of the screen 
in the Finder. 

The Macintosh can switch to a different startup disk while you're working. 
You can also force the Macintosh to switch when you want another disk to be 
the current startup disk (if you want to use different fonts or desk accessories, 
for example). 

The Macintosh switches to a different startup disk whenever 

o You restart the Macintosh using a different startup disk. The Macintosh 
follows the normal order in looking for a startup disk. 

o You explicitly open an application (not a document) on another startup 
disk. (If you're using a hard disk, this doesn't cause a switch.) 

o You open a document on another startup disk and the original startup disk 
does not contain the document's application. (If you're using a hard disk, 
this doesn't cause a switch.) 

You can also force the Macintosh to switch to a different startup disk. You can 
do this in one of the following ways: 

o Hold down the Option key while you open an application. (This forces a 
switch whether or not other conditions are met, as long as the application 
is on a startup disk; it's especially useful if you have a hard disk.) 

o Hold down the Option and Command keys while you double-click the 
Finder icon on the disk you want to switch to. 

When you're using a disk that's initialized two-sided, the current System and 
Finder files must be together in the same folder. This is because the 
Macintosh now looks in just one folder for the System and Finder it needs, 
rather than looking at the entire disk. 
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Using the 
FontlDA Mover 
to Customize 
Startup Disks 

Although similar to past versions of the FontiDA Mover (Font and Desk 
Accessory Mover), FontiDA Mover version 3.0 is an improved version that 
works better with the new system files. Old versions of FontiDA Mover or Font 
Mover won't work with your upgraded Macintosh. Discard any old version 
you have and use only the new version included on the System Tools disk. 

The Font and Apple menus within applications always contain the fonts and 
desk accessories installed in the System file (a file in the System Folder) on 
the current startup disk. The FontiDA Mover lets you modify the System file 
on any startup disk to contain the fonts and desk accessories you want to 
have when you use applications with that disk. 

As new fonts and accessories become available, you may want to add them 
to some of your startup disks. And when you need more space on a disk, you 
can also use the FontiDA Mover to remove fonts or accessories. 

You can store collections of fonts and accessories in special files the 
Macintosh uses just for that purpose. The System Tools disk includes two 
extra desk accessories-the Note Pad and the Puzzle-in the Desk 
Accessories and Fonts files in the Utilities Folder. You may want to add them 
to some of your other startup disks. 

• Open the FontlDA Mover by selecting the Icon and choosing 
Open from the File menu or by double-clicking the Icon. 

The FontiDA Mover is included on the System Tools disk. You can also 
open any font or desk accessory file to open the FontiDA Mover 
automatically. 

@Font 
o Desk Accessory 

Chicago 12 
Courier 10 
Courier 12 
Geneva 9 
Geneva 10 
Geneva 12 
Geneva 14 

System 
on System Tools 

365K free 

J v 

Help 

Mover 

( Close 1 ( Quit 1 (open ... :l 
............................................................................................................................................................................. ~ ........... . 
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• Click either the Font or the Desk Accessory button, depending 
on what you want to add or remove. 

The list on the left includes all fonts or desk accessories in the System file 
on the current startup disk, whether the disk is in the internal or the 
external disk drive. (If you open a font or desk accessory file instead of 
the FontiDA Mover, the list on the left shows the contents of that file.) 

• Use the Open buttons to present lists of other System, font, or 
desk accessory files on any Inserted disk. 

Each Open button lets you control what's displayed in its list. If you insert 
a startup disk, its System file is automatically displayed. Whenever you 
click an Open button, a dialog box appears with a directory of folders and 
System, font, or desk accessory files on the current disk or in the current 
folder. See "Using Folders From Within Applications." 

The name of the disk you're looking at is always shown at the top right. 

Use the Drive and Eject buttons to look at System, font, or desk accessory 
files on other disks. 

• Open the file you want to look at by selecting its name and 
then clicking Open or by double-clicking Its name. 

You can look at and work with any existing System, font, or desk 
accessory files. The font and desk accessory files on the System Tools 
disk contain fonts and desk accessories you may want to add to some of 
your startup disks. If you'd like, create a new file for your own collection 
of fonts or accessories by clicking New, naming the file, and clicking 
Create. 

• Select the fonts or desk accessories you want to copy or 
remove. 

You can select from either list. Click to select a single font or accessory, 
hold down the Shift key while you click additional single fonts or 
accessories, or drag to select a group. Shift-click to deselect a selected 
file. The number of bytes selected is shown as well as the amount of 
space available on the disk. Both the name of the current file and the 
disk it's on are displayed below each list. When a single font is selected, 
the name, size, and a sample of the font are shown at the bottom of the 
window; when more than one font is selected or when a desk accessory is 
selected, nbthing is displayed there. 
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System Fonts 
on System Tools 

365K free 

Close 

Help on System Tools 
365K free 

Quit Close 

• Click Copy to copy the selected fonts or accessories In the 
direction the arrows point, or click Remove to remove them. 

Clicking Copy copies the fonts or desk accessories to the opposite file ; 
clicking Remove removes the fonts or accessories from the file they're in. 
If a font or accessory with the same name as one you selected already 
exists in the opposite list, it will be replaced by the selected font or 
accessory. If you remove all fonts or accessories from a font or accessory 
file, the file itself will be gone the next time you click Open. You can't 
remove certain fonts the Macintosh needs. 

Only fonts and accessories in the current startup disk's System file are 
available to applications you use with that startup disk. You're limited to a 
total of 15 accessories in a System file . 

• Click Quit. 

In the Finder, you can drag any font or accessory files you no longer need 
to the Trash, or copy or move these files among disks. 

You can use the FontiDA Mover to create an auxiliary set of fonts or 
accessories. Later you can move the current System file fonts or accessories 
to another font or accessory file you create, and then copy the auxiliary set to 
your System file. You can use the FontiDA Mover to alternate between the 
files whenever you want. 
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folder(s). See also directory 
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Note Pad file, 35 

o 

one-sided format. See single-sided disks 
Open command, 25, 33 
Option key 

initializing and, 34 
Key Caps and, 24 

42 Macintosh Plus Internal Disk Drive 



p, a 

padlock,15 
Page Setup command, 11 
Print Catalog command, 11 
Printer port, 20, 21 
printing resources, 6 

Chooser and, 20 
Installer and, 7-8 
startup disks and, 35 

pull-down list, 27 
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Limited Warranty on Hardware 

APPLE COMPUTER, INC. ("Apple") warrants the Macintosh Plus Internal Disk Drive against 
defects in materials and workmanship for a period of NINETY (90) DAYS from the date of original 
retail purchase. 

If you discover a defect, Apple will, at its option, repair, replace, or refund the purchase price of 
the product at no charge to you, provided you return it during the warranty period, transportation 
charges prepaid, to the authorized Apple dealer from whom you purchased it or to any other 
authorized Apple dealer within the country of original retail purchase. (You can obtain additional 
information from Apple directly at the address printed in the inside front cover of this manual.) 
Please attach your name, address, telephone number, a description of the problem and a copy of the 
bill of sale bearing the appropriate Apple serial numbers as proof of date of original retail purchase, 
to each product returned to warranty service. 

This warranty applies only to hardware products; Apple software media and manuals are warranted 
pursuant to a separate written statement. 

This warranty does not apply if the product has been damaged by accident, abuse, misuse or 
misapplication, has been modified without the written permission of Apple, or if any Apple serial 
number has been removed or defaced. 

ALL IMPLIED WARRANTIES, INCLUDING IMPLIED WARRANTIES OF 
MERCHANT ABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN 
DURATION TO NINETY (90) DAYS FROM TIIE DATE OF TIIE ORIGINAL RETAIL 
PURCHASE OF THIS PRODUCT. 

TIIE WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU 
OF ALL OTHERS, ORAL OR WRITTEN, EXPRESS OR IMPLIED. No Apple dealer, agent, or 
employee is authorized to make any modification, extension, or addition to this warranty. 

APPLE IS NOT RESPONSIBLE FOR SPECIAL, INCIDENTAL, OR CONSEQUENTIAL 
DAMAGES RESULTING FROM ANY BREACH OF WARRANTY, OR UNDER ANY LEGAL 
THEORY, INCLUDING LOST PROFITS, DOWNTIME, GOODWILL, DAMAGE TO OR 
REPLACEMENT OF EQUIPMENT AND PROPERTY, AND ANY COSTS OF RECOVERING, 
REPROGRAMMING, OR REPRODUCING ANY PROGRAM OR DATA STORED IN OR 
USED WITH APPLE PRODUCTS. 

Some states do not allow the exclusion or limitation of implied warranties or liability for incidental 
or consequential damages, so the above limitation or exclusion may not apply to you. This 
warranty gives you specific legal rights, and you may have other rights which vary from state to 
state. 

See inside front cover for warranty information on software media and manuals. 
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